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The exact appearance of Windows varies depending upon the version of Windows you are
using. Windows XP is used throughout although for the purpose and scope of this guide, the

differences between versions of Windows are largely cosmetic.
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This guide assumes the reader to have basic knowledge of
text editing and formatting using a Wordprocessor. Familiarity
with Office XP's adapting menus and toolbars is also assumed.
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1.1

SECTION 1

INTRODUCTION

A database is a collection of information (data) which is systematically organised. There are
many examples of databases in everyday life, for example, an attendance register, a shop
stock list, a telephone book. Using a database management system (database program) like
Access, databases such as these can be manipulated and searched. For example, Access
would allow you to sort a database of publications into alphabetical order based on the
author’s name, and to search for the author of a particular publication. Access can sort or find
information much faster than you could by hand so looking through huge lists of information
becomes a practical proposition. Data can also be manipulated using Access, eg. you could
find out the total number of publications there are in the database, or how many by a
particular author, or published after say, 1980.

Databases are structured into tables, records and fields. A table consists of a set of records
(rows). Each record contains a number of distinct fields (columns). An example of a record
would be information about a particular publication, say the book ‘For Whom The Bell Tolls’.
Examples of fields are the author, the publisher, and the ISBN (International Standard Book
Number).

As with database programs generally, before you start to use Access you should consider
carefully what information you wish to record, the form in which you wish to record it, and
what data you may want to retrieve from the database.

Database Design

Database design is a big topic – entire books have been written on the subject. Traditionally
it has been viewed as a difficult task requiring highly specialised skills and consuming a great
deal of time and effort. Whilst this may be true for large shared databases which have to take
into account a wide range of considerations and users, small or single-user databases are not
necessarily always difficult to design and implement. Outlined below are a number of
principles that you should keep in mind when you are designing a database.

There are two types of database: Flat File Databases and Relational Databases. Both types can
be created using Access.

Flat file databases are a simple type of database which consist of a single table of data, for
example, a telephone book. While simpler in design, flat file databases can be inefficient if
used to store inappropriate types of data as this can lead to a lot of repetition in the database.
In such cases more than one table is required and this is termed a relational database.

Consider the example of a library loan database where a person may borrow several books.
If this was to be implemented as a flat file database there would need to be a record containing
details about each book including a field for the name of the borrower. If the person were
borrowing six books her name would be repeated six times in the database alongside the
records of the six books borrowed. In addition the database would need to store the Person’s
library card number and the loan date. Of course each of these would also have to be stored
six times – not very efficient. While with a small-scale database this may not seem important,
the larger the database grows the more cumbersome it becomes to search and manipulate.
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In a relational database details about the book would be kept in a separate table from those
of the borrower; in this way the tables can be linked (related) together by a single common
field. This linking field is the only repetition required between the tables and this is much
more efficient.

The key to relational databases is the process of deciding which tables you should have in the
database, how these tables are related, and what fields those tables should contain. A
frequent problem in the design of databases is that too few tables are used which can lead
to them becoming overloaded or difficult to search, update and expand.

You need to consider carefully the sorts of questions you will want to ask the database and
the types of output you will require. Very often you may have to review the design.

Stages in Creating a Database

1 Decide upon the design of your database. Section 1.1.

2 Create the required tables based upon your design and define the fields within each
table. Section 2.3.
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3 Enter the data for the database

4 If you wish to make data entry easier create a Form. Section 5.0

5 Search the database using a Query. Section 4.0.
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6 If you wish to print any data from the database as anything other than a simple listing
use a Report. Section 6.0.

Sample Database

Throughout this guide the examples are based on a database designed to operate a local
library loan system. The purpose of the database is to enable the library to store and retrieve
information about which publications are on loan and to whom.

The following information needs to be recorded about the publications available: which
publications are on loan, to whom, and details about people registered to use the library. Each
has been logically allocated to one of four tables with the linked element underlined:

Publication: ISBN, Title, Author, Publisher, Loan Period, Times Borrowed, Type of
Publication, On Loan.

Loan: ISBN, Library Card Number, Loan Date.

Borrower: Library Card Number, Name, Loan Limit, Adult.

Details: Library Card Number, Address, Telephone Number.

While this may appear intimidating, examples in this guide will refer only to the Publication table
unless illustrating how to relate tables together and how these can then be manipulated.

The database was divided in this
way because it has broken the
information which is needed into
four distinct entities. The tables
are linked either by the ISBN
number or the Library Card
Number (underlined above).
Structuring the database in such
a way makes it more efficient to
use and reduces problems of
duplication and inconsistencies.

The diagram opposite illustrates the relationship between the four tables which constitute
the database.

You should note that the sample database is intended purely as an illustration and that some
licence has been taken.
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SECTION 2

STARTING ACCESS

Unlike most programs where it is possible to get started with little background knowledge,
the same is not true of a relational database program. Getting the initial design of the
database right is essential.

If you have not done so
already, it is suggested that
you read Section 1.0 of this
guide and if you are still in
any doubt then read a book
about database design.

To begin using Access
choose All Programs
from the Start menu and
Microsoft Access from
the sub-menu or click on
the Access button on the
Office Shortcut bar.

The window shown left is
displayed.

There are two ways of starting Access:

• Using a database which has already been set up (see Section 2.2).

• Setting up a new database (see Section 2.3).

Help Using Excel

If you have problems with Access the Access Help pane
to the right of your screen may be able to help. Type the
topic that you require help with into the Search for: box
and click on      . Usually a selection of possible answers is
returned, and for further details just click on the most
appropriate answer.

2.1
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Note: To remove the Access Help pane to
give you more room to work click on      .
To display the Access Help panel choose
Microsoft Access Help from the Help menu.
If another task pane is displayed to the right
of the screen choose Help from the drop
down menu.

The Office Assistant: The Office Assistant is an animated character who provides an
alternative to the Excel Help panel. If you would like to display the Office Assistant choose
Show the Office Assistant from the Help menu.

Pop-up Icons: You may find that common icons pop up while you are working. These icons
are designed to help you complete routine tasks, such as inserting or formatting a new line.
Click on the icon to take advantage of the shortcuts available.
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Opening an Existing Database

You may have experience of inputting data or working with an Access database created by
someone else. If you wish to adapt an existing database or modify one that you have already
created. In either case if Access has just started up you will be presented with a dialogue box
similar to the one shown below.

To the right of the workbook is the Task pane which
disappears and reappears depending upon your usage of
Access. If the database you wish to open has been in use
recently then it may be listed in the Task pane. If so a single
click on the name of the database will open it.

If the database you wish to open is not listed then click on
More Files and find the database using the Open dialogue
box. To open a file on a particular disc choose the disc by
clicking on the arrow alongside the Look in box and double-
click on the disc from those listed. If the file was saved into a
particular folder double-click on the folder from those listed
and when the desired file name appears in the dialogue box,
open it either by clicking on the file name and then on the
Open button, or by double-clicking the file name.

If the Task pane is not displayed choose Open from the File menu or click on the
        button on the Toolbar. The dialogue box below will appear from which you can open
the required database file.

2.2
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Once a database is open the
Database window is displayed and
from this you can choose which
type of database object you wish
to use. If you wish to view data in
a datasheet click on the Tables
button, choose the table you wish
to view and click on the Open
button. Similarly, if you wish to
view data as a form click on the
Forms button, choose the form
you wish to view and click on the
Open button.

Note: The distinction between a datasheet and a form is made later in the guide.

Creating a New Database

To create a new database you must decide whether to begin from scratch with a blank
database or to be guided in creating the database by the Database Wizard. The Database
Wizard provides several ready-made databases templates (see Section 2.4), if your informa-
tion is consistent with one of these templates then using the Database Wizard is certainly the
easiest way to create your database.

Databases created using the database wizard can be
modified to suit your particular requirements both
during and after creation, though this can be compli-
cated, and ultimately more time consuming than creat-
ing a database from scratch.

If Access has just started up the Task pane will be
displayed on the right of the window, if it is not shown
choose New from the File menu to display it.
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2.5

2.4 Creating a Database Using the Database Wizard

Access provides a number of templates for databases designed for common purposes. To utilise
these templates choose Templates from the New File task pane.

To determine whether the database you wish to create corresponds with one of the Database
Wizard templates ensure that the dialogue box displayed has the Databases tab to the fore.

If one of the templates is suitable choose it
and click on the OK button. In the dialogue
box which follows you must decide where
to save the database file and title it appro-
priately (for more detail see Section 7.0).

You will then be presented with a series of
dialogue boxes, the responses to which
allow you to customise the database to
your requirements. For example, you can
choose from a variety of pre-defined tables
and fields whether to include sample data,
and you can then choose the style used to
display the data.

Note: A database created using the Database Wizard is no different to one created from
scratch. If you wish to add fields, change the names of tables, or alter the appearance of
the database just use the techniques outlined in the following sections.

Creating a Database from Scratch

By default your database will usually be saved to a folder called ‘My Documents’ on the hard
disc or network disc. If you wish to save to a different disc click on the down-arrow alongside
the Save In box and choose the disc from those listed. If you wish to save to a different folder
double-click on the folder from those listed in the dialogue box.

Next replace the default file name ‘db1’ in the file name box with an appropriate file name
for your database.

Click on Create to create the database.

The tables of the database must now be created.
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Creating Tables

To create a table you must decide whether to begin with a blank table or to be guided in
creating the table by the Table Wizard. The Table Wizard provides many ready-made tables
for you to use and, as with database templates, if this suits your purpose it is certainly the
easiest way to create tables. However, more likely than not your data will not conform to one
of these ready made tables and you will then need to create your own table from scratch.

To create a table click on the Ta-
bles button in the Database win-
dow and choose Create table in
Design view, Create table by
using wizard or Create table by
entering data and click on the

New button.

Creating a Table using the Table Wizard

To determine whether the table you wish to create corresponds with one of the pre-defined
tables, choose Create table by using wizard. A series of dialogue boxes is presented; the first
displays the pre-defined tables and associated fields.

2.6

2.7
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If one of the sample tables shown on the left of the dialogue box is suitable choose it and
examine the associated sample fields. If all the fields in each of the tables are suitable for
use in your database, click on the      button to nominate them as fields in your table.
Alternatively, for each field which is suitable, select the field and click on the        button.
Repeat this for each field you wish to use in the table. If none of the tables is suitable click
on Cancel and create your table from scratch (see Section 2.8).

Note: You can construct your table using sample fields from different sample tables.

Fields may be removed from use using the          button. All fields from a particular table may
be removed by clicking on the        button.

Fields may be renamed by selecting them from the Fields in my new table section of the
dialogue box and clicking on the Rename Field button. Simply enter the alternative into the
dialogue box presented.

Subsequent Table Wizard dialogue boxes require you to name the table, decide upon how
the primary key is specified (Section 2.13), establish any relationships between this and any
other tables (Section 2.14) and finally decide how to proceed when the table is created.

Creating a Table from Scratch

To create a table from scratch choose create table in Design View. A new table will be created.
It is at this stage that the fields of the table are defined (see Section 2.9).

More than one table can be created in this way but first the current table must be titled and saved.
Saving in Access is different from other programs. For information about saving see Section 7.0.

To close a table you no longer wish to use choose Close from the File menu.

Defining Fields

Database tables use a number of categories or fields in which data is stored. Library catalogues
– cards with author’s name, title of publication, publisher, date of publication – are a case in
point of a physical database now increasingly replaced by an electronic one. Each element
– name, title, publisher etc. is a field, and these must be defined before data can be entered.

To define fields a table needs to be viewed in Design View. If you using a view other than
design view the left-most button on the Toolbar will be displayed as        . Click on this button
to switch to design view.

From the design view window the fields common to every record of the database are defined.

To define a field, type the name you have chosen for the field into the column beneath Field
Name. Long field names can be accommodated by increasing the width of the column. To do
this move the pointer to the line which divides the titles of the Field Name and Data Type columns.
The pointer will change shape. Now click and drag right to widen the column as required.

Press the Tab (→/) key to move to the Data Type column and choose a data type by clicking
on the down-arrow      and making your choice from the pop-up menu. Definitions of the
field data types are provided in Section 2.10. Press the Tab (→/) key to move on to the
Description column where you may if you wish include a full description of the field.

2.8

2.9




